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 Chapter 3:

• • • • • •
 QuicKeys Overview

This chapter explains how to use QuicKeys and provides an overview o
QuicKeys architecture. Reading this chapter will acquaint you with the
capabilities of QuicKeys so you can take full advantage of the software
power and flexibility. 

QuicKeys Actions and Sequences
QuicKeys Actions and Sequences are the foundation of the QuicKeys 
program. QuicKeys Actions automate simple one-step tasks, such as 
choosing a network printer. QuicKeys Sequences automate multi-step tasks,
such as starting a database program, searching for a specific item and
printing out the selected database records. Actions can be built using S
Wizards or the Action Properties dialog. Sequences are built using a 
collection of Actions that can be assembled manually or by using the 
QuicKeys recording feature. The recording feature enables QuicKeys t
“watch” what you are doing and repeat your actions.

Creating Actions and Sequences
Probably the single most important factor involved in using QuicKeys is
understanding the concept behind its usage. QuicKeys is a powerful 
software tool you can use to automate your computer. It’s a tool, howe
that is only as effective as you make it. Once you install QuicKeys, you n
to make a mental note of the tedious, routine tasks you perform on you
computer and earmark those tasks for some attention from QuicKeys. E
time you think of something that QuicKeys could make easier for you, 
create an Action or Sequence that automates that task, or series of tas
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When you create a QuicKeys Action or Sequence, you can choose the
trigger that launches it. In other words, you need to specify the “signal” 
tells QuicKeys when to perform the Action or Sequence. For example, if yo
want QuicKeys to open a database program and enter the current date
time, you need to let QuicKeys know when to begin. You can use a hot
(such as F5), or a number of other available QuicKeys triggers (such a
toolbars, the QuicKeys menu, or timed triggers) to communicate with 
QuicKeys that you want to begin this Sequence. It’s kind of like having
personal assistant inside your computer that understands a language 
triggers you choose.

That’s all there is to using QuicKeys: thinking of tasks to automate, crea
QuicKeys Actions or Sequences that replace those tasks, and triggerin
tasks. You need to spend a few minutes telling QuicKeys what you want
from that point on you save hours, days, maybe even weeks with the Ac
or Sequence that only took you a couple of minutes to set up. It’s a pre
good return for a small investment of time. In fact, after using QuicKeys
a few weeks, you will probably be amazed when you recall how much 
your day was once spent searching through folders, rearranging window
your desktop, or clicking the same options in countless windows.

QuicKeys Components
Part of understanding any piece of software is understanding its differe
components. Understanding the parts of QuicKeys will familiarize you w
the logic behind the QuicKeys architecture, making it easier to find thin
and use the software more efficiently. 

QuicKeys is composed of three main elements: the QuicKeys Editor, th
QuicKeys Engine and QuicKeys plug-ins. This section familiarizes you w
each of these components.

❖ For a diagram of the QuicKeys architecture, see page 213.
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QuicKeys Editor
When you select QuicKeys from the Start menu, the QuicKeys Editor 
displays. It is your control center for creating, editing, and deleting Actio
There are four separate tabs available in the QuicKeys Editor that each 
a different purpose: the Setup Wizards tab, the My Keyboard tab, the My Toolbars 
tab, and the My Actions tab. 

The QuicKeys Editor Tabs

Use the Setup Wizards tab as a starting point 
for setting up Actions with the Setup Wizard.

Use the My Keyboard tab to quickly add or 
change hot key triggers for existing Actions.

Create, edit, and delete toolbars from the My 
Toolbars tab.

View all your QuicKeys Actions and their 
properties from the My Actions tab. This 
illustration uses the Details view, but you can 
also select the Large Icons, Small Icons, or 
List views from the View menu.
QuicKeys Overview 15 
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The Setup Wizards Tab
When you first start QuicKeys, you see a tabbed window that displays 
Setup Wizards tab as the frontmost tab. Click one of the buttons in the Setup 
Wizards tab to be guided through the process of setting up an Action that
automate the task described on the button. When your cursor is positio
over an Action button for more than one second, a hot help description o
Action displays.

Click a Setup 
Wizard button to 
start the Setup 
Wizard for that 
Action.

Figure 3: Click a button in the Setup Wizards tab to be guided 
through the process of creating, editing, and deleting 
Actions.

Click the drop-down arrow to 
display a list of Setup Wizard 
viewing options.

Wizard window 
label. This text 
changes 
depending on 
which group of 
Setup Wizards is 
displayed.

Online Help 
instructions.

Standard program 
toolbar.
hapter 3 



        

yout 
ck a 

. 
The My Keyboard Tab
When you click the My Keyboard tab, you see a diagram of your keyboard 
along with a tabbed Action Sets pane. Raised keys in the Keyboard La
pane indicate the keys that QuicKeys is currently using as triggers. Cli
raised key to display the Action it triggers in the right side of the window

Figure 4: Use the My Keyboard tab to assign hot key triggers to 
your Actions. The standard keyboard layout is shown 
here, but you can also specify a laptop keyboard layout. 
See page 39 for more information.

The selected key displays in 
the right-most pane of the My 
Keyboard tab along with any 
Actions that use that key.

Modifier keys 
used in 
combination 
with the 
selected key.

Keys that are raised are assigned 
to existing Actions. F4 is one of 
the raised keys in this illustration.

There is a different 
tab for each Action 
Scope. See page 28 
for more information.

The Action(s) that use the 
selected keyboard key.

You can use the 
Options dialog 
discussed on 
page 39 to select a 
different Keyboard 
Layout that more 
closely matches 
your keyboard. 

Select a column 
heading to sort 
Actions by that 
category.

The Action Sets 
pane displays all 
of your Actions.

Hot keys can be 
edited by clicking in 
the Hot key column 
and pressing the new 
key combination you 
want assigned.
QuicKeys Overview 17 

• 
• 
• 
•
•
•



 

18

 

  C

 

• 
• 
• 
•
•
•

           

, 
e 
Drag and drop Actions from the Action Sets pane 
to one of the Keyboard Layout buttons to assign or 
reassign a hot key. When you release the mouse, 
the menu shown in Figure 5 appears. Use the 
menu to choose modifier key(s) that will be 
pressed simultaneously with the selected 
Keyboard Layout key. 

For example, if you drag a Type Text Action from 
the Universal tab to the F8 key, the menu shown in 
Figure 5 displays. If you select (None), F8 will 
trigger the Type Text Action. If you select 
Ctrl+Alt+Shift, you must press Ctrl+Alt+Shift+F8 to 
trigger the Type Text Action.

❖ You can also access the modifier key menu by 
right-clicking an Action listed in the far right pane of the My Keyboard tab and 
selecting the Modifiers option.

Right-click an Action in the Action Sets pane to cut, copy, paste, delete
select, change the view, or display advanced options or properties of th
selected Action. See Figure 6 for an illustration of this context menu.

Figure 5: The modifier 
menu

Figure 6: Right-click an Action in the Action Sets pane of the My Keyboard tab to 
display the context menu.
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Right-click the Actions listed in the far right 
pane to Delete, display the Properties, Advanced 
options, clear the selected hot key, or select 
Modifiers for the selected Action.

The My Toolbars Tab
When you click the My Toolbars tab, you can 
see a list of all your toolbars. Toolbars are 
graphical representations of specific tasks on 
the computer. Most programs provide 
toolbars that perform a specific function, such as printing, when you cl
the Print icon. QuicKeys toolbars are different, however, because you 
specify the appearance and functionality of the toolbar.

Toolbars are a valuable asset if you have created several QuicKeys Act
They provide a quick and easy way of triggering your Actions. You don
have to remember a hot key and you don’t have to fill up your QuicKey
menu if you use toolbars to trigger at least some of your Actions.

Figure 7: Right-click an 
Action in the far 
right pane of the 
My Keyboard tab 
to display the 
above menu.
QuicKeys Overview 19 

• 
• 
• 
•
•
•



 

20

 

  C

 

• 
• 
• 
•
•
•

   

 of 

    

e 
ar, 

  

ay 

  

g.

  
When you click the toolbar name in the My Toolbars tab of the QuicKeys 
Editor, all the Actions that reside on that toolbar display in the right side
the window.

• Right-click a toolbar in the My Toolbars tab to create a new toolbar, creat
a new toolbar button, display the Toolbar Button Wizard, hide the toolb
delete the toolbar, or display the toolbar’s properties.

• Right-click in the Toolbar Buttons pane to create a new button, displ
the Toolbar Button Wizard, or delete the selected toolbar button.

• Double-click a toolbar to display the toolbar’s Action Properties dialo

• See Chapter 4, “QuicKeys Toolbars” on page 47 for more detailed 
information about toolbars.

Figure 8: Use the My Toolbars tab to create, edit, and delete 
QuicKeys toolbars.

When you select a toolbar in the My 
Toolbars tab, the buttons placed on 
that toolbar display in the Toolbar 
Buttons pane.

Click a column heading to 
choose how your toolbars are 
sorted. For example, when you 
click the Toolbar Name header, 
the listed toolbars are 
arranged alphabetically by 
name. 

A list of your 
toolbars.
hapter 3 



        

t 

  

ns 

    

 

                

ope.
The My Actions Tab
When you click the My Actions tab, all of your Actions display in the defaul
Details view. This tab is useful when you want to view and edit all the Actio
you created from a single window.

• Double-click an Action in the My Actions tab to display a Setup Wizard or
an Action Properties dialog where you can edit the Action.

• Right-click an Action to Cut, Copy, Delete, Select, Change the view, or display 
the Properties of the selected Action.

• Drag-and-drop an Action from one tab to another to edit the Action sc

There is a 
different tab for 
each Action 
Scope you have 
specified. See 
page 29 for more 
information.

Click a column heading to 
choose how you want your list of 
QuicKeys Actions sorted.

Figure 9: Use the My Actions tab to view, create, or edit your 
Actions.

Double-click an 
Action to edit it.

If an Action is available in the 
QuicKeys menu, the menu icon 
in the Triggers column is bolded. 
If a timed trigger is set up for an 
Action, the timer icon appears 
bolded.

Click in the Hot key 
column and press 
the hot key you 
want to use to 
trigger the selected 
Action.
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Sequence Editor
You can open the Sequence Editor by selecting Sequence in the Create menu. 
The Sequence Editor enables you to consolidate Actions into a more 
advanced Sequence, so it’s likely you may not choose to use the Sequen
Editor until you are comfortable creating QuicKeys Actions. A Sequence is 
a collection of Actions that completes a multi-step task. For example, y
can create a Sequence that launches your E-mail application, types you
name and password, and clicks OK in the appropriate dialog. The Sequenc
would contain four separate Actions that are individually only capable o
completing a single task until they are combined into a Sequence.

Add steps to your Sequence 
using the options in the 
Create menu.

Move the insert arrow 
to specify where you 
want the new Action or 
Sequence tool 
inserted.

Double-click a 
Sequence 
step to edit it.

If the Sequence does 
not execute 
successfully, a dialog 
displays the Step ID 
number where the 
Sequence is having 
difficulty.

Specify conditional branching 
for each step of the 
Sequence. See page 190 for 
more information.

Figure 10: Use the Sequence Editor to modify your Sequences. 
See Chapter 12, “Building Multi-Step Actions” for more 
information on Sequences.
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The Sequence Editor allows you to edit each step of a Sequence. The
three different methods for opening the Sequence Editor:

• Record a Sequence and it appears automatically. See page 188 for
information on recording.

• Select Sequence in the Create menu.

• Double-click a Sequence listed in the My Actions tab.

QuicKeys Engine
The QuicKeys Engine is a background program that is necessary for th
QuicKeys Editor to function. Most of the time you don’t need to pay an
attention to the Engine because it’s started whenever you turn on your
computer. However, if you ever turn off the QuicKeys Engine, it’s importa
to know how to turn it back on because your Actions won’t work withou

When you install QuicKeys, a shortcut to the QuicKeys Engine is place
the Startup Items folder. The only time you may need to exit the QuicK
Engine is when you install new programs that require you exit all progra
In such a situation, you can right-click the QuicKeys icon located on th
taskbar and choose Exit to quit the Engine. Use one of the following method
to restart the Engine:

• Restart your computer 

• Select QuicKeys from the Programs menu in the Windows Start menu
QuicKeys Overview 23 
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QuicKeys Plug-ins
A plug-in is a software 
component that adds 
functionality to 
QuicKeys. There are 
several plug-ins 
available in QuicKeys. 
Each plug-in can be 
turned on or off 
individually and third 
party plug-ins can 
easily be added to 
QuicKeys due to its 
flexible architecture. 

If you want more 
information about 
turning plug-ins on or off, see page 34. If you are interested in extending
power of QuicKeys by creating your own plug-ins, visit CE Software’s W
site at http://www.quickeys.com/.

QuicKeys Menu
By default, a QuicKeys icon displays in your taskbar after installation. 
When you right-click that icon, the QuicKeys menu appears. In the 
QuicKeys menu you can:

Figure 11: You can manage QuicKeys Plug-ins from the 
Plug-in Manager window. When you click the 
+ icon to expand a plug-in, you can see the 
Actions that are included in that plug-in.

• Trigger QuicKeys Actions • Create toolbars

• Start/Stop recording a 
Sequence

• Open the QuicKeys About 
box

• Open toolbars • Open the QuicKeys Editor

• Exit QuicKeys • Abort the playback of a 
sequence
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Adding Actions
You can add Actions to the QuicKeys menu by selecting the Include in 
QuicKeys menu check box in the Setup Wizard or in the General tab of the
Action Properties dialog. The hot keys assigned to each Action also ap
in the QuicKeys menu unless you have cleared the option to Show hot keys in 
QuicKeys menu in the Options dialog. See page 39 for more information.

If the QuicKeys icon or QuicKeys hot keys are not displayed in your task
check to make sure the Show icon in taskbar and Show hot keys in QuicKeys menu 
options are selected. You can view these items by selecting Options from the 
QuicKeys Editor View menu.

Using QuicKeys
There are two rudimentary steps involved in using the QuicKeys progra
setting up Actions or Sequences and triggering Actions. This section 
provides general information about this process. For information on spe
Actions, see the corresponding chapter in this manual. For example, 
Chapter 12 discusses “Building Multi-Step Actions” in detail.

Figure 12: The QuicKeys menu in the 
Windows taskbar

Actions created with 
QuicKeys

Click the submenu 
arrow to view or create 
toolbars

Select “Abort 
Sequence” to stop the 
playback of a 
Sequence, “Start 
Recording” to record a 
new Sequence, or 
“Stop Recording” to 
stop recording a new 
Sequence.

Click to open the 
QuicKeys Editor

This option closes 
the QuicKeys Editor 
and the QuicKeys 
Engine.

Right-click the 
QuicKeys icon to 
display the QuicKeys 
menu.

Displays the QuicKeys 
About box, where you 
can browse registration 
and system 
information, CE 
Software credits, and 
relevant Web sites.
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The process of setting up QuicKeys looks something like this:

Creating QuicKeys Actions
When you create a QuicKeys Action, you can use the Setup Wizard (sh
in Figure 13) or the Action Properties dialog (shown in Figure 14) to spe
how the Action behaves. The Setup Wizard is used by default because
prompts you for information in a step-by-step fashion. If you are a mor
advanced user, you can turn off the Setup Wizard in the Options dialog
instead use the Action Properties dialog. The Action Properties dialog 
presents all the setup options for an Action in a single dialog. See pag
for more information.

Whichever method you use to create QuicKeys Actions is completely 
dependent upon your comfort level with QuicKeys.

• Click a Setup Wizard button 
in the Setup Wizards tab

• Set the options you want to 
use in the Setup Wizard. 
Make sure you set the 
trigger (such as a hot key) 
you want to use to activate 
the Action.

• Click Finish when you reach 
the end of the Setup Wizard. 
Your Action is saved as soon 
as you click the Finish 
button.

• Select the trigger you 
specified to activate the 
Action. QuicKeys should 
react to the trigger and 
complete the task 
immediately.

Setting Up Actions

Triggering Actions
hapter 3 
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Using the Setup Wizard
When you begin using 
QuicKeys, you will 
probably use the Setup 
Wizard because it provides 
the most basic method for 
creating QuicKeys. You 
simply click an Action 
button in the Setup Wizards 
tab and a series of wizard 
dialogs guide you through 
the process of setting up or 
editing a QuicKeys Action.

Using the Action 
Properties Dialog
When you are more 
comfortable with 
QuicKeys and you 
want to use a more 
direct approach to 
create and edit 
Actions, you can 
select a plug-in from 
the Create menu to 
open the Action 
Properties dialog. 
Action Properties are 
the options you 
specify for each 
QuicKeys Action you 
have created. The 
Action Properties are 
presented to you item-by-item when you use the Setup Wizard to crea
Actions; however, all the Action Properties are presented in a single di
when you use this more advanced method of creating and editing QuicK
Actions.

Figure 13: The Introduction page of the Setup 
Wizard appears when you click a button 
in the Setup Wizards tab.

Figure 14: The Action Properties dialog for the Web 
Launcher Action appears when you select 
Web Launcher from the Internet Tools 
submenu in the Create menu.
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General—Supply the 
name of the Action and 
the hot key that triggers it 
in this tab. You can also 
select the Include in 
QuicKeys menu check box 
to list the Action in the 
QuicKeys menu or click 
the Clear hot key button to 
clear the contents of the 
hot key field. 

➣ You must use the Clear hot key button to clear the hot key field because th
Delete and Backspace keys cannot delete a hot key.

Toolbars—Click the 
Toolbars Tab to select the 
toolbar in which you want 
this Action displayed.

Action Scope—Specify 
the range of operation for 
the Action. In other 
words, choose whether 
the Action works at any 
time, or whether it can 
only be triggered from the 
desktop, from a specific 
program, or from a 
particular hardware 
profile. 

Figure 15: The General tab is located at the top of 
the Action Properties dialog shown in 
Figure 14.

Figure 16: The Toolbars tab is located at the top of 
the Action Properties dialog shown in 
Figure 14.

Figure 17: The Action Scope tab is located at the 
top of the Action Properties dialog 
shown in Figure 14.
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When you trigger a 
QuicKeys Action, 
QuicKeys examines the 
Action Scope you set in 
order to determine 
whether or not it should 
trigger the Action. This 
decision process is 
illustrated in Figure 18.

There is no limit on the 
number of Action 
scopes you can specify, 
but if you have a set of 
Actions for each 
program you use, you 
may have too many tabs 
for the QuicKeys Editor 
to display. If this 
happens, small arrows 
appear on the right side 
of the QuicKeys Editor. Click the arrows to scroll through the list of Actio
Scope tabs. 

To delete a particular Action Scope tab, delete or reassign the scope for
of the Actions in that tab. Then, close and restart the QuicKeys Editor. W
the QuicKeys Editor displays, the Action Scope tab you chose is no lon
displayed.

•Universal: Universal is selected by default for each Action you create. U
Universal when you want to be able to trigger the Action at any time, 
regardless of what program you are in or whether or not the deskto
active. 

❖ Buttons on toolbars are always Universal in scope.

•Desktop: Select Desktop when you only need to trigger the Action from
the desktop. This option is useful for your toolbars. When toolbars a
assigned Desktop scope, they appear whenever the desktop is active.

QuicKeys 
trigger

Desktop 
Scope

Program-specific 
Scope

Hardware Profile Scope

Universal Scope

Figure 18: This diagram illustrates Action Scope 
priority from the most specific Scope 
selection to the least specific Action 
Scope option.
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•Program: When you select Program, a Program drop-down list appears 
where you can choose the program in which you want to use the Ac
Click the Browse button and navigate to the program you want to use if 
program is not listed in the drop-down list. This scope option is usefu
you have several Actions you only need to use within a program, suc
Microsoft Access.

•Hardware Profile: A hardware profile is a set of instructions specifie
within your operating system that tell your computer which devices 
start when you turn on your computer. In other words, hardware profi
enable you to categorize QuicKeys Actions under different hardware
identities. 

For example, you can set up the F5 key as the QuicKeys hot key that tell
your portable computer to switch to Standby mode when your computer is
using a Docked Hardware Profile. Additionally, you can use the F5 key 
within the Undocked Hardware Profile scope to shut down your comput
when your computer is undocked. The same hot key works differen
depending upon the “state” of your computer.

Timed Triggers—
Choose a specific time 
you want the Action to be 
triggered. By default, 
there is no timed trigger 
selected.

Action-Specific 
Properties—The Action 
Properties dialog 
contains an Action-specific 
properties pane that is 
unique for each 
QuicKeys Action. 

Figure 19: The Timed Triggers tab is located at the 
top of the Action Properties dialog 
shown in Figure 14.

Figure 20: The Action-specific properties pane for 
the Web Launcher Action.
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Triggering Actions
QuicKeys provides a variety of ways to trigger Actions so you can use 
methods that make sense to you. QuicKeys makes customizing the wa
work easy.

You can use any or all of 
the following triggers 
for each QuicKeys 
Action:

• Hot key—The key(s) 
on the keyboard used 
to trigger your 
QuicKeys Actions.

• Toolbars—The 
collection of 
QuicKeys buttons 
that enable you to 
simply point and 
click to open files or 
folders, trigger 
Actions, or display 
QuicKeys Action 
menus.

• Timed triggers—
The specific 
date/time, time of 
day, or repeating 
interval when 
QuicKeys Actions are automatically triggered.

• QuicKeys menu—The menu that appears when you right-click the 
QuicKeys icon in the taskbar. Trigger Actions by selecting them from 
QuicKeys menu.

• Shortcut on desktop—Drag-and-drop an 
Action to the desktop or Start menu to create a 
Windows shortcut to the Action. This option is 
useful for Actions you use frequently. See 
Figure 22 for an illustration of a desktop 
shortcut.

Figure 21: You can set your triggers in the various 
tabs of the Action Properties dialog or in 
the Triggers page of the Setup Wizard.

Figure 22: A Windows 
shortcut to a 
QuicKeys 
Sequence
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Managing QuicKeys
This section discusses standard procedures, such as printing and savi
QuicKeys Actions. It also provides information on turning individual 
Actions on and off, resolving hot key conflicts, and importing/exporting
Actions.

Printing Actions
If you want to print a list of your Actions, select 
Print from the File menu. The same Action list is 
printed regardless of which QuicKeys Editor tab is 
in the foreground. The following information is 
printed:

• Action names

• Action descriptions

• Hot keys assigned to Actions

• Whether or not Actions are displayed in the QuicKeys menu.

Saving Actions
Your Actions are automatically saved whenever you click Finish in the Setup 
Wizard or click OK in the Action Properties dialog. However, if you create
Sequence, you are prompted to save your changes to the Sequence.
hapter 3 



Clearing Hot Keys
When you no longer 
want a hot key assigned 
to an Action, click the 
Clear hot key button in the 
Action Properties tab. 
There is a separate 
Action Properties dialog 
for each QuicKeys 
Action.

Do not try to clear your 
hot keys with the Delete 
or Backspace keys because QuicKeys will begin to use those keys as 
triggers.

Figure 23: This graphic shows the upper half of the 
Action Properties dialog where the Clear 
hot key button is located. To open the 
Action Properties dialog for editing, double-
click the Action you want to edit in the My 
Actions tab. 
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Disabling/Enabling Actions
If you find that you do not have a need for some of the Actions installed w
QuicKeys, you can turn those Actions off so they no longer display in t
QuicKeys Editor. For example, if you use a PC that does not have a so
card and if you don’t use your CD-ROM drive for audio CDs, you proba
don’t need any of the multimedia Actions, such as CD/DVD or Set Aud
Volume. 

To enable/disable Actions:

1 Select Plug-ins from the View menu.
2 In the QuicKeys Plug-in Manager dialog, click the + and - icons to expand and 

contract the various Action categories.

3 Select the Actions or Action categories you no longer wish to view and click the 
Disable button.

4 Click Close when you are finished.
5 Look at the My Actions tab of the QuicKeys Editor. The Actions you cleared in 

the Plug-in Manager are no longer displayed.

Figure 24: Use the QuicKeys Plug-in Manager to enable 
or disable plug-ins and Actions.

plug-ins

Actions
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Resolving Hot Key Conflicts
Hot key conflicts occur when a hot key in one Action Set conflicts with a 
key in another set or a hot key that is built into another program. For 
example, let’s say the F5 hot key is assigned to two Actions. One hot k
opens Photoshop and is universal in scope. The other hot key change
layout of a document and can only be triggered in a specific database 
program. What happens when you press F5?

QuicKeys follows rules of priority to resolve hot key conflicts. When the
same hot key is used for several different tasks, the resulting Action dep
upon where the hot key falls in the following hierarchy:

A. Program-specific hot keys

B. Universal hot keys

C. Hot keys defined by a particular program

Applying this information to the above example, if the database program
open, F5 formats a database document. If the database program is not the 
active program, F5 starts Photoshop.

If you don’t want to change assigned hot keys to avoid these conflicts,
can either use the QuicKeys Controller to turn your hot keys on/off for 
brief period of time, or you can substitute QuicKeys hot keys for the hot k
that are built into the programs you use.

Enable/Disable Hot Keys
If hot key conflicts only occur in programs you use very infrequently, th
best way to avoid them is to turn your QuicKeys hot keys on and off us
the QuicKeys Controller Action. This feature enables you to briefly disa
a QuicKeys hot key while you work in a program that uses conflicting h
keys. When you are finished working in the program, you can turn QuicK
hot keys back on.

For example, you may want to disable QuicKeys hot keys while working
Microsoft® Excel™ if Excel uses Ctrl+1 to insert cells, but you have direct
QuicKeys to use Ctrl+l to change selected text to italics.
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The easiest way to enable or disable 
hot keys is by using the QuicKeys 
Controller Action Menu button that 
was automatically placed on your 
QuicKeys toolbar when you installed 
QuicKeys. However, if you edited the 
toolbar and that button is no longer 
available to you, use the following 
instructions to set up this Action.

To turn QuicKeys hot keys on and 
off using the Setup Wizard:

1 Start QuicKeys.
2 Select the Setup Wizards tab.
3 Click the QuicKeys Controller 

button.
4 Read the introduction page 

and click Next.
5 Select Create a new Action 

and click Next.
6 Select Set status of QuicKeys 

and click Next.
7 Select Toggle status and click 

Next.
8 A name is automatically 

assigned to the Action. You 
can use the assigned Action name or type a different one.

9 Select the Assign hot key check box and click Next.
10 Click in the Hot key box and press the F11 key.
11 Click Next.
12 Click Finish.

Now simply press F11 to turn QuicKeys hot keys on and off.

Figure 25: You can disable hot keys 
and timers from the 
QuicKeys Controller 
Action Menu located on 
your QuicKeys toolbar.
hapter 3 
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Reassigning Built-in Program Hot Keys
If hot key conflicts occur in programs you use on a daily basis, you nee
change either the hot keys QuicKeys assigned or the hot keys (or short
your programs use. You can change your QuicKeys hot keys simply by
going through the QuicKeys Setup Wizard and pressing a different hot
when you see the wizard page with the Hot key field. To change your 
built-in program hot keys, you can use the Type Keystroke Action. For 
information on using the Type Keystroke Action, see page 137.

Importing Action Sets
You can import Action Sets when you receive QuicKeys Action Sets fro
other QuicKeys users or when you want to use some of the Action sets
installed with QuicKeys. When you import Actions, you import all the 
attributes originally assigned to the particular Actions. For example, yo
import the triggers, icons, and scope selections for the Actions. If the sc
of the Action is invalid in the new environment, the scope is automatica
reassigned to Universal.

To import your Action Set:

1 Select Import from the File menu.
2 Navigate to the location of the Quickeys Action Set you want to import and 

select the file with the .qkx extension.
3 Click Open. The Action Set is immediately imported into your collection of 

QuicKeys Actions. Look in the My Actions tab to view them.

❖ You can also double-click a .qkx file to import it into your collection of 
QuicKeys Actions.

Importing Sample Files
QuicKeys installs a Sample Files directory that contains several sampl
toolbars, Sequences and other helpful QuicKeys files. There is a Read
file in the Samples directory that you should read for information about
sample files. When you choose the Import option from the QuicKeys Editor 
File menu, navigate to the Program Files\CE Software\QuicKeys\Samp
Files directory. You can choose a file from the samples provided or navi
to a different directory to import your custom files.
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Importing Duplicate Hot Keys
If you import QuicKeys Actions that 
use hot keys that are already assigned 
to existing Actions, the dialog in 
Figure 26 appears. 

Import new Actions without hot 
key assignment—Unassigns hot 
keys for imported Actions that use 
existing hot key triggers. Imported 
Actions that do not use existing hot 
keys retain their hot key trigger after 
import. 

Import new Actions and unassign 
existing hot key triggers—Unassigns existing hot keys so imported hot 
keys can use them. All imported Actions retain their hot keys, while Actio
that already exist in the My Actions tab are stripped of their hot key 
assignments.

Cancel the import of new Actions—Stops the import of new Actions.

Exporting Action Sets
You can export Action Sets when you want to share your QuicKeys Acti
with other QuicKeys users or when you want to back up your Actions. W
the Setup Wizard tab is displayed, you can export all of your QuicKeys 
Actions. If any of the other tabs are displayed, only selected Actions are 
exported. When you export Actions, all attributes are exported. These 
attributes include the triggers, icons, and scope assignments for the Ac
being exported. 

To export your Action Set:

1 Select the Actions you want to export.
2 Select Export or Export Selection from the File menu.
3 Choose where you want to save the exported file and click Save. Your Action 

Set is saved to the location you specified.

Figure 26: The QuicKeys Import dialog 
appears when QuicKeys 
notices duplicate hot keys 
as it imports new Actions.
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Customizing QuicKeys
There are several different ways to customize QuicKeys. For example,
can choose whether or not the introduction page appears in the Setup W
and what type of view you use in the My Actions tab. You can also resize a 
QuicKeys Floating toolbar by clicking a corner of the toolbar and dragg
it so it appears as a single, double, or triple-column toolbar. It’s comple
up to you.

Setting QuicKeys Options
You can customize what you see when you run QuicKeys in the Options 
dialog. Click Options in the QuicKeys View menu to view the Options dialog.
You choices include:

Keyboard Layout—Choose the keyboard 
layout that is similar to the keyboard you 
use. You can choose between a standard or 
laptop layout. 

Show icon in taskbar—Displays the 
QuicKeys icon in your taskbar. You can 
right-click the QuicKeys icon to display the 
QuicKeys menu.

You can disable this option if you do not 
want to trigger Actions from the QuicKeys 
menu. When this check box is cleared, the 
Option dialog’s Show hot keys in QuicKeys menu check box is dimmed.

Show hot keys in QuicKeys Menu—Displays the hot keys assigned to you
Actions in the QuicKeys menu. Show Icon in taskbar must be selected for this
option to be available. 

You may want to disable this option if you only want Action names to 
display in the QuicKeys menu.
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Show Setup Wizard 
introduction page—Displays the 
introduction page in the Setup 
Wizards whenever you create or 
modify an Action from the Setup 
Wizards tab. When you become 
familiar with what each Action 
does, you may want to disable this 
option to go through the Setup 
Wizard more quickly.

Always use Setup Wizards for 
editing—Displays a Setup Wizard 
each time you modify an Action. When this check box is cleared and y
attempt to modify an Action from the My Actions tab, the Action Properties 
dialog appears rather than a Setup Wizard. Clear this option if you are
advanced QuicKeys user and you do not want to use wizards.

Show sequence recording toolbar—
Displays a QuicKeys recording toolbar after 
you select the Start Recording option so you can 
control recording with a click of your mouse.

Show sequence playback toolbar—Displays 
a playback toolbar when you are running a 
Sequence so you can control the playback of a 
QuicKeys Sequence with a click of your 
mouse.

Figure 27: The introduction page of the 
Setup Wizard.

Pause

Stop Cancel

Pause Cancel

Current 
Sequence 
step
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Resizing Toolbars
You can resize toolbars by clicking on a corner of the toolbar and dragg
it until it appears as a long, single-row toolbar or a short, multi-row tool

Sorting Information
You can choose how you want to sort information in the different QuicKe
dialogs by clicking a column header.

Changing Views in the My Actions Tab
You can view the My Actions tab in any of the views available in the View 
menu. You can choose from the following views:

Using Online Help
You can access QuicKeys Help from the Help menu, from the QuicKeys 
menu, by pressing F1, or by clicking the Help button. The Help system allows
you to browse or search topics using the Contents, Index, or Find tabs
the Contents and Index tabs as you would use the table of contents or 
in a standard manual. Use the Find tab as you would use the Find featu
a standard software product.

The Help system installed with QuicKeys is different than the printed 
manual in that it is written to answer specific questions you may have as
use the QuicKeys software. In contrast, this printed manual is written t
teach you about QuicKeys using detailed explanations and examples.

• Large Icons • Small Icons

• List • Details

Figure 28: You can resize toolbars to whatever dimensions you prefer. 
QuicKeys Overview 41 

• 
• 
• 
•
•
•



42  C

• 
• 
• 
•
•
•

 
 your 

ith 
Your First Action
By now you’ve probably completed the QuickStart Wizard, so you have
already created some Actions. However, this section takes you through
first Action from beginning to end just as you would set up Actions without 
the QuickStart Wizard. 

In the following instructions, you create an Action that opens Notepad w
a hot key.

How to Set Up and Use a QuicKeys Action
1 Right-click the QuicKeys menu in the taskbar and select Open QuicKeys Editor.
2 In the Setup Wizards tab, 

select the Open button.
3 Read the introduction page 

and click Next.
4 In the Setup Wizard, select 

Create a new Action and click 
Next.

5 Select Program and click 
Next.

6 Select Notepad from the 
program list and click Next.

7 Type a name for the new 
Action if you do not want to 
use the default name, 
Notepad.

8 Select the Assign hot key box 
and click Next.

9 Press the F7 key and click 
Next.

10 Click Finish.
11 Press F7. The Notepad program should start. Remember this hot key trigger so 

you can use it whenever you want to open Notepad. See “Triggering Actions” 
on page 31 for more information on hot keys and other triggers.

Figure 29: The wizard introduction page appears 
whenever you attempt to create or 
edit an Action. If you do not want the 
introduction page to display for any of 
your Actions, clear the 
“Show...introduction page” check box 
discussed on page 40.
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Setting Up Multiple Actions
If you don’t want to go through the Setup Wizard 5 times for 5 different
Actions, you can create all 5 Actions simultaneously using the Create/edit 
multiple Actions option. The Create/edit multiple Actions option is available for the 
following Actions:

To create multiple Actions simultaneously:

1 Select an Action in the Setup Wizards tab that offers the Create/edit multiple Actions 
option.

2 Read the Introduction page and click Next.
3 Select Create/edit multiple Actions and click Next.
4 Read the Multiple Action Introduction page and click Next.

• Advanced Text Tools • CD/DVD

• Change Folder • Choose Printer

• Instant E-mail • Open

• QuicKeys Clipbook • QuicKeys Controller

• Screen Settings • Set Audio Volume

• Type Date/Time • Windows Specials

• Dial-Up Networking
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5 Select the check box for each Action you wish to create.

6 Choose whether you want to trigger the Actions using hot keys or the QuicKeys 
menu. If you want to use a hot key, position your cursor in the Hot key column 
and press a hot key. If you want to use the QuicKeys Menu, click the Menu 
column.

Deleting Multiple Actions
You can delete multiple Actions simultaneously from the QuicKeys Edi
My Actions tab. Just Ctrl+click the Actions you want to delete and then rig
click the selected Actions. Select Delete from the context menu that appear

Using the QuickReference Card
The QuickReference Card is a window that displays all your QuicKeys
Actions and corresponding hot keys. Its main purpose is to jog your mem
if you forget which hot key performs which Action. You can launch Actio
by clicking them in the QuickReference Card, or you can simply use th
QuickReference Card to view the Actions and hot keys you have creat

Click in the Hot key 
column and press the 
hot key you want to use 
to trigger the selected 
Action.

Click in the Menu 
column to toggle the 
selection of whether or 
not to include the Action 
in the QuicKeys menu.

Click the Clear hot key 
button to delete your hot 
key selection in the Hot 
key column.

Figure 30: This dialog appears when you click 
“Create/edit Multiple Actions” in the 
Setup Wizard.
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By default, QuicKeys uses the Shift+Ctrl+Space hot key to open the 
QuickReference Card. When triggered, the QuickReference Card open
the tab representing Actions in the most restrictive scope. For example
FileMaker is open when you press Shift+Ctrl+Space, the Actions scope
FileMaker appear in the frontmost QuickReference Card tab. If there ar
Actions scoped to FileMaker, the Universal tab is frontmost.

Exiting QuicKeys
When you want to close the QuicKeys Editor, simply click the QuicKey
Editor close box or select Exit from the File menu. However, if you select Exit 
QuicKeys from the QuicKeys menu, the QuicKeys Engine is turned off. To 
turn it back on again, you must click the Windows Start menu and sele
QuicKeys from the Programs submenu.

Figure 31: Use the QuickReference Card to help remember your hot 
keys. In this example, FileMaker Pro is the active program 
so the Actions scoped to FileMaker appear in the 
frontmost tab of the QuickReference Card.

Figure 32: By default, you can exit the QuicKeys program from the Windows 
taskbar. The QuicKeys menu is located in the status area, or tray, of 
the taskbar.
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